
  

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT

 

Note Note

Click the “KORG” logo. Select “ Load Controller Map...” from the displayed KORG logo menu. Load the 
controller settings file “M1.cmap” from the “Presets” folder inside the folder where the KORG Legacy 
Collection is installed.

G Ch:01G Ch:01G

E4 F4

Note Note

Click the “KORG” logo. Select “Load Controller Map...” from the displayed KORG logo menu. Load the 
controller settings file “M1 Le.cmap” from the “Presets” folder inside the folder where the KORG Leg-
acy Collection is installed.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Click the “KORG” logo. Select “Load Controller Map...” from the displayed KORG logo menu. Load the 
controller settings file “MS-20.cmap” from the “Presets” folder inside the folder where the KORG Leg-
acy Collection is installed.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Click the “KORG” logo. Select “Load Controller Map...” from the displayed KORG logo menu. Load the 
controller setting file “Polysix.cmap” from the “Presets” folder inside the folder where the KORG Leg-
acy Collection is installed.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Click the controller logo on the “PERFORMANCE” page. Select “Load Controller Map...” from the dis-
played controller menu. Load the controller setting file “LegacyCell.cmap” from the “Presets” folder 
inside the folder where the KORG Legacy Collection is installed.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Click the “FILE” button at the bottom of the screen. Click the “LOAD” button in the display and make 
the popup menu appear. Choose “Controller Map...” from the popup menu. Load the controller set-
ting file “MonoPoly.cmap” from the “Presets” folder inside the folder where the KORG Legacy Collec-
tion is installed.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

1: Connect the M50’s MIDI OUT jack to the microKORG’s MIDI IN jack with a MIDI cable. 
2:  Set the microKORG’s EDIT SELECT 2 knob to “MIDI”. Move Knob 1 to set the MIDI CH to “1". Move 

Knob 3 to set the CLOCK to “Ext”. 
3: Set the EDIT SELECT 2 knob to “GLOBAL”. Move Knob 4 to set the POSITION to “PrE” (Pre TG). 
4: Press the 4 key while holding the SHIFT key to enter MIDI Filter settings. Move Knob 1 to select “P-

E” (PROGRAM CHANGE Enabled). Move Knob 2 to select “C-E” (CONTROL CHANGE Enabled). Move 
Knob 3 to select “b-E” (PITCH BEND Enabled).

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4
M50 External Setups

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1

0

KORG

KLC M1

Name OSC BAL RESO CUTOFF EG INT ATTACk DECAY RELEASE IFX BAL Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 CC#71 CC#74 CC#79 CC#73 CC#75 CC#72 CC#91 C4 D4

1 KLC M1 Le

Name OSC BAL Free CUTOFF EG INT ATTACK DECAY RELEASE Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 off CC#74 CC#79 CC#73 CC#75 CC#72 CC#7 C4 D4

2 KLC WAVESTATION

Name Vector X Vector Y Free Free Free Free Free Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#16 CC#17 off off off off off CC#7 C4 D4

3

KLC MS-20

[A]

Name VCO 1 WAVE FORM VCO 2 WAVE FORM HPF CUTOFF LPF CUTOFF EG 1 DELAY EG 1 ATTACK EG 1 RELEASE VOLUME Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#82 CC#28 CC#74 CC#24 CC#23 CC#26 CC#7 C4 D4

4 [B]

Name VCO 1 LEVEL VCO 2 LEVEL HPF PEAK LPF PEAK EG 2 ATTACK EG 2 DECAY EG 2 SUSTAIN EG 2 RELEASE Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#20 CC#21 CC#29 CC#71 CC#73 CC#75 CC#70 CC#72 C4 D4

5

KLC Polysix

[A]

Name VCO WAVE FORM VCO PWM ADJUST VCF CUTOFF VCF RESONANCE FX MODE FX SPEED PAN VOLUME Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#14 CC#74 CC#71 CC#12 CC#93 CC#10 CC#7 C4 D4

6 [B]

Name MG FREQUENCY MG DELAY TIME MG LEVEL EG ATTACK EG DECAY EG SUSTAIN EG RELEASE VOLUME Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#27 CC#24 CC#76 CC#73 CC#75 CC#70 CC#72 CC#7 C4 D4

7

KLC LegacyCell

[Encoder]

Name Encoder 1 Encoder 2 Encoder 3 Encoder 4 Encoder 5 Encoder 6 Encoder 7 Encoder 8 Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#28 CC#29 CC#30 CC#31 CC#74 CC#71 CC#85 CC#79 C4 D4

8 [Slider]

Name Slider 1 Slider 2 Slider 3 Slider 4 Slider 5 Slider 6 Slider 7 Slider 8 Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#15 CC#5 CC#20 CC#82 CC#22 CC#18 CC#21 C4 D4

9

KLC Mono/Poly

[A]

Name XMOD INT FREQ MOD PWM INT VCF Cut VCF Reso VCF int Pan Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#12 CC#13 #CC15 #CC74 #CC71 #CC79 #CC10 #CC7 C4 D4

10 [B]

Name VCF EG ATTACK VCF EG DECAY VCF EG  SUSTAIN VCF EG  RELEASE EG ATTACK EG DECAY EG SUSTAIN EG RELEASE Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note #CC28 #CC29 #CC30 #CC31 #CC73 #CC75 #CC70 #CC72 C4 D4

11

microKORG

[A]

Name OSC 1 Wave Filter Cutoff Filter Resonance Filter EG Int F.EG Attack F.EG Decay F.EG Sustain LFO 1 Frequency Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#74 CC#71 CC#79 CC#23 CC#24 CC#25 CC#27 C4 D4

12 [B]

Name OSC 1 Control2 OSC 2 Tune OSC 1 Level OSC 2 Level A.EG Attack A.EG Decay A.EG Sustain A.EG Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#15 CC#19 CC#20 CC#21 CC#73 CC#75 CC#70 CC#72 C4 D4



 

Note Note

1: Connect the M50’s MIDI OUT jack to the MS2000/R’s MIDI IN jack with a MIDI cable. 
2: Press the [GLOBAL] key to enter Global mode. Set “Position” on the “GLOBAL” page to “Pre TG”. 
3: Press the [PAGE] key to move to the “MIDI” page. Set “MIDI Ch” to “01” and “Clock” to “External”. 
4: Press the [PAGE] key to move to the “MIDI FILTER” page. Set “ProgChg” to “ENA”, “CtrlChg” to “ENA”, 

“P.Bend” to “ENA", “NoteRcv” to “ALL”, and “TimbreSelect” to “CC#95”.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

1: Connect the M50’s MIDI OUT jack to the RADIAS' MIDI IN jack with a MIDI cable. 
2: Press the [GLOBAL] key to enter Global mode. Set “Position” on the “GLOBAL” page to “Pre TG”. 
3: Press the [PAGE] key to move to the “MIDI” page. Set “MIDI Ch” to “01” and “Clock” to “Ext-MIDI”. 
4: Press the [PAGE] key to move to the “MIDI FILTER” page. Set “ProgChg” to “o”, “CtrlChg” to “o”, 

“P.Bend” to “o”.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

1: Connect the M50’s MIDI OUT jack to the R3’s MIDI IN jack with a MIDI cable.
2: Turn [PAGE SELECT] dial to move to “EDIT-P40 Global-A” page and set [KNOB4]’s “Position” to “Pre 

TG.”
3: Turn [PAGE SELECT] dial to move to “EDIT-P42 MIDI” page and set [KNOB1]’s “MIDI Ch” to “01", 

[KNOB4]’s “Clock” to “Ext-MIDI.”
4: Turn [PAGE SELECT] dial to move to “EDIT-P43 MIDIFilt” page and set [KNOB1]’s “PROG Chg” to 

“Enable,” [KNOB2]’s “Ctrl Chg” to “Enable”, [KNOB3]’s “PitchBend” to “Enable.”

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Free Free

Load the “KORG M50 template.als” file.
Select “Preferences...” in the “Options” menu (or select “Preferences...” from the “Live” menu on the 
Mac) to open the “Preferences” dialog. Set “Input” of “Remote Control” to “M50(KEYBOARD)”.

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Note Note

Select “Import...” from the “File” menu and load the setting file “KORG Midi Links.lx3".

G Ch:01G Ch:01G

E4 F4

  

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Select “Import...” from the “File” menu and load the setting file “KORG Midi Links.axf” file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT
13

KORG

MS2000/R

[A]

Name OSC 1 Wave Filter Cutoff Filter Resonance Filter EG 1 Int EG 1 Attack EG 1 Decay EG 1 Sustain LFO 1 Frequency Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#74 CC#71 CC#79 CC#23 CC#24 CC#25 CC#27 C4 D4

14 [B]

Name OSC 1 Control2 OSC 2 Tune OSC 1 Level OSC 2 Level EG 2 Attack EG 2 Decay EG 2 Sustain EG 2 Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#15 CC#19 CC#20 CC#21 CC#73 CC#75 CC#70 CC#72 C4 D4

15

RADIAS

[A]

Name OSC1 Wave Filter 1 Cut Filter 1 Resonance Filter 1 Balance EG 1 Int EG 1 Attack EG 1 Decay EG 1 Sustain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 CC#74 CC#71 CC#27 CC#79 CC#85 CC#86 CC#87 C4 D4

16 [B]

Name OSC 1 Control2 LFO 1 Frequency OSC 2 Tune Amp Level EG 2 Attack EG 2 Decay EG 2 Sustain EG 2 Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#17 CC#90 CC#21 CC#7 CC#73 CC#75 CC#70 CC#72 C4 D4

17

R3

[A]

Name OSC1 Wave Filter 1 Cut Filter 1 Resonance Filter 1 Balance EG 1 Int EG 1 Attack EG 1 Decay EG 1 Sustain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 CC#74 CC#71 CC#27 CC#79 CC#85 CC#86 CC#87 C4 D4

18 [B]

Name OSC 1 Control2 LFO 1 Frequency OSC 2 Tune Amp Level EG 2 Attack EG 2 Decay EG 2 Sustain EG 2 Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#17 CC#90 CC#21 CC#7 CC#73 CC#75 CC#70 CC#72 C4 D4

19

Ableton Live

[Send]

Name Track 1 Send Track 2 Send Track 3 Send Track 4 Send Track 5 Send Track 6 Send Track 7 Send Track 8 Send Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#18 CC#18 CC#18 CC#18 CC#18 CC#18 CC#18 CC#18 Off Off

20 [Pan]

Name Track 1 Pan Track 2 Pan Track 3 Pan Track 4 Pan Track 5 Pan Track 6 Pan Track 7 Pan Track 8 Pan Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 Off Off

21 [Volume]

Name Track 1 Volume Track 2 Volume Track 3 Volume Track 4 Volume Track 5 Volume Track 6 Volume Track 7 Volume Track 8 Volume Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off

22

Applied Acoustics 
Systems

Lounge Lizard EP-3

[A]

Name
Mallet Stiffness soft/
hard

Mallet Force strength Mallet Noise pitch Mallet Noise decay Fork Tine Decay Fork Tine volume Fork Tone Decay Fork Tone Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 C4 D4

23 [B]

Name
Pickup Geometry 
Symmetry

Pickup Geometry 
Distance

Pickup Volume Input
Pickup Volume Out-
put

EQ Low Gain EQ Mid Gain EQ High Gain Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#7 C4 D4

24

Ultra Analog VA

[A]

Name OSC1 Detune OSC1 PW FILTER1 Cutoff FILTER1 Q AMP1 Level AMP1 Pan LFO1 Rate LFO1 Delay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 C4 D4

25 [B]

Name FILTER1 ENV1 A FILTER1 ENV1 D FILTER1 ENV1 S FILTER1 ENV1 R AMP ENV1 A AMP ENV1 D AMP ENV1 S AMP ENV1 R Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#59 C4 D4

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



 

Note Note

Select “Import...” from the “File” menu and load the setting file “KORG Midi Links.sxf” file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Select “Import...” from the “File” menu and load the setting file “KORG Midi Links.lls” file.G Ch:01G Ch:01G

E4 F4

Note Note

Select “Import...” from the “File” menu and load the setting file “KORG Midi Links.uas” file.G Ch:01G Ch:01G

E4 F4

Note Note

Copy the setting file “controlMidi” into the following folder:
Windows: The “save” folder inside the folder where minimoog V is installed. (e.g. C:Program Files/
Arturia/minimoog V/save)
Mac: /Library/Preferences/minimoog V/save folder This operation will overwrite the previous MIDI 
Control settings. If necessary, back up the previous controlMidi file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Copy the setting file “controlMidi” into the following folder: 
Windows: The “save” folder inside the folder where CS-80V is installed. 
(e.g. C:/Program Files/Arturia/CS-80V/save)
Mac: /Library/Preferences/Cs80V/save folder. This operation will overwrite the previous MIDI Control 
settings. If necessary, back up the previous controlMidi file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Copy the setting file “controlMidi” into the following folder:
Windows: The “save” folder inside the folder where Moog Modular V is installed. (e.g. C:/Program 
Files/Arturia/Moog Modular V/save)
Mac:/Library/Preferences/MoogModularV/save folder This operation will overwrite the previous MIDI 
Control settings. If necessary, back up the previous controlMidi file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Copy the setting file “controlMidi” into the following folder:
Windows: The “save” folder inside the folder where ARP2600 V is installed. 
(e.g. C:/Program Files/Arturia/ARP2600V/save)
Mac: /Library/Preferences/arp2600v/save folder This operation will overwrite the previous MIDI Con-
trol settings. If necessary, back up the previous controlMidi file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT
26

Applied Acoustics 
Systems

String Studio VS

[A]

Name Chorus Mix Chorus Depth Chorus Rate Delay Mix Delay Depth Delay Rate Reverb Mix Reverb Decay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 C4 D4

27 [B]

Name
Excitator Prot (Force, 
Mass)

Excitator Stiff (Fric-
tion)

Excitator Velocity Filter Cutoff Filter Q EQ Low Gain EQ Mid Gain EQ High Gain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#102 CC#103 CC#104 CC#105 CC#106 CC#107 CC#108 CC#109 C4 D4

28 Lounge Lizard Session

Name Piano Tune Tremoro Depth Tremolo Speed Drive amount Effect Depth Reverb mix Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#71 CC#70 CC#92 CC#79 CC#16 CC#12 CC#91 CC#19 C4 D4

29 Ultra Analog Session

Name Keyboard Glide Filter Cutoff Filter Q Filter Env Attack Filter Env Amount AMP Attack AMP Release AMP Level Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#5 CC#74 CC#71 CC#85 CC#79 CC#73 CC#72 CC#7 C4 D4

30

Arturia

minimoog V

[A]

Name Wave Osc 1 Wave Osc 2 Wave Osc 3 Cutoff Emphasis VCF Attack VCF Decay VCF Sustain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#16 CC#17 CC#18 CC#74 CC#71 CC#49 CC#50 CC#51 C4 D4

31 [B]

Name Level Osc 1 Level Osc 2 Level Osc 3 Level Ext Amount VCA Attack VCA Decay VCA Sustain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#80 CC#81 CC#82 CC#83 CC#87 CC#88 CC#89 CC#90 C4 D4

32

CS-80V

[A]

Name Attack Time Vca 1 Decay Time Vca 1 Sustain Level Vca 1 Release Time Vca 1 Attack Time Vca 2 Decay Time Vca 2 Sustain Level Vca 2 Release Time Vca 2 Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#92 CC#94 CC#95 CC#96 CC#97 CC#98 CC#99 CC#100 C4 D4

33 [B]

Name HighPass 1 Cutoff
HighPass 1 Reso-
nance

LowPass 1 Cutoff LowPass 1 Resonance HighPass 2 Cutoff
HighPass 2 Reso-
nance

LowPass 2 Cutoff
LowPass 2  Reso-
nance

Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#65 CC#66 CC#67 CC#68 CC#69 CC#70 CC#72 CC#73 C4 D4

34

moog modular V

[A]

Name
Filter 1 Cutoff Fre-
quency

Filter 1 Resonance
Filter 2 Cutoff Fre-
quency

Filter 2 Resonance
Filter 3 Cutoff Fre-
quency

Filter 3 Resonance VCA Envelope 1 Gain VCA Envelope 2 Gain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#80 CC#16 CC#81 CC#17 CC#82 CC#18 CC#89 CC#90 C4 D4

35 [B]

Name 125Hz Band Gain 350Hz Band Gain 1000Hz Band Gain 2800Hz Band Gain 175Hz Band Gain 500Hz Band Gain 1400Hz Band Gain 4000Hz Band Gain Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#106 CC#107 CC#108 CC#109 CC#110 CC#111 CC#112 CC#113 C4 D4

36

ARP2600 V

[A]

Name POLTAMENTO TIME DELAY Dry/Wet DELAY time L DELAY time R AUDIO VCO1 AUDIO VCO2 AUDIO VCO3
Encoder 8 AUDIO 
NOISE

Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 C4 D4

37 [B]

Name
INT.FIRTER FRE-
QUENCY

RESONANCE ADSR FILTER TYPE A D S R Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#59 C4 D4

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



 

Note Note

Copy the setting file “controlMidi” into the following folder:
Windows: The “save” folder inside the folder where Prophet V is installed. 
(e.g. C:/Program Files/Arturia/ProphetV/save)
Mac: /Library/Preferences/prophetv/save folder This operation will overwrite the previous MIDI Con-
trol settings. If necessary, back up the previous controlMidi file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Copy the setting file “midi.prefs” into the following folder:
Windows: The “save” folder inside the folder where Analog Factory is installed. (e.g. C:/Program Files/
Arturia/Analog Factory/save)
Mac: /Library/Preferences/AnalogFactory/save folder This operation will overwrite the previous MIDI 
Control settings. If necessary, back up the previous controlMidi file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Click the “Load” icon (located in the upper right corner of the BFD window) to load the 
“BFD_KORG.bfd” file.

G Ch:01G Ch:01G

F#2 A#2

Note Note

G Ch:01G Ch:01G

F#2 A#2

Note Note

G Ch:01G Ch:01G

F#2 A#2

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note
For stand-alone operation Windows: Click the “SET UP” button in the lower right part of the “mini-
monsta” window to open the menu. Click on “Input device” and select “M50 KEYBOARD”. Mac: Click 
the “SET UP” in the lower right part of the “minimonsta” window to open the menu. Click on “Input 
device” and select “CoreMIDI”.

G Ch:01G Ch:01G

E4 F4

Note Note

For stand-alone and plug-in synthesizer operation Select “MIDI settings” (located in the “OPTIONS” 
menu in the upper left corner of FL STUDIO window), and select “M50 1 KEYBOARD”. Select “Open” 
from the “FILE” menu, and load the “KORG M50.flp” file.

G Ch:01G Ch:01G

D5 D#5

Note Note

G Ch:01G Ch:01G

D5 D#5

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT
38

Arturia

Prophet V

[V]

Name Osc A PW Filter Cutoff Filter Resonace Filter Env Amount Amp Env A Amp Env D Amp Env S Amp Env R Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#20 CC#74 CC#71 CC#79 CC#73 CC#75 CC#70 CC#72 C4 D4

39 [VS]

Name Filter Env Amount Filter Cutoff Filter Resonace Volume LFO1 Rate LFO2 Rate pad X Pad Y Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#69 CC#30 CC#68 CC#83 CC#90 CC#76 CC#16 CC#17 C4 D4

40

Analog Factory

[A]

Name Level Cut Off Resonance LFO Rate LFO Amt Chorus Delay Free Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#7 CC#74 CC#71 CC#90 CC#89 CC#93 CC#91 Off C4 D4

41 [B]

Name Param 1 Param 2 Param 3 Param 4 Amp Env A Amp Env D Amp Env S Amp Env R Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#18 CC#19 CC#16 CC#17 CC#73 CC#75 CC#70 CC#72 C4 D4

42 Apple GarageBand

Name Pan Volume Free Free Free Free Free Free Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#10 CC#7 off off off off off off C4 D4

43

Fxpansion BFD

[master]

Name Direct Master Level Overhead Level Room Level PZM Level Master Dynamics Master Level Free Free Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#16 CC#17 CC#18 CC#19 CC#11 CC#7 off off B1 D2

44 [trim]

Name Kick Trim Snr Trim HiH Trim F Tom Trim M Tom Trim H Tom Trim Cym 1 Trim Cym 2 Trim Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#59 B1 D2

45 [tune]

Name Kick Tune Snr Tune HiH Tune F Tom Tune M Tom Tune H Tom Tune Cym 1 Tune Cym 2 Tune Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 B1 D2

46

GMEDIA

impOSCar

Name Filter Frequency Filter Q Filter Separation Filter Amount Vel Attack Vel Release Vel Drive Vel Env2 Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#73 CC#52 CC#36 CC#37 CC#38 CC#39 C4 D4

47 M-Tron

Name Volume Tone Pitch Amp Env Attack Amp Env Relese Free Free Free Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#7 CC#74 CC#95 CC#73 CC#72 off off off C4 D4

48 Oddity

Name
VCF Cutoff Fre-
quency

VCF Resonance HPF Cutoff Freq Q LFO Freq Q ADSR Attack ADSR Decay ADSR Sustain ADSR Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#9 CC#8 CC#75 CC#76 CC#77 CC#78 C4 D4

49 minimonsta

Name Filter Emphasis Filter Cutoff Filter Contour VCF Attack VCF Decay VCA Attack VCA Decay Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#71 CC#74 CC#70 CC#20 CC#21 CC#73 CC#72 CC#7 C4 D4

50

Image-Line Software FL Studio

[Pan]

Name Master Pan FX1 Pan FX2 Pan FX3 Pan FX4 Pan FX5 Pan FX6 Pan FX7 Pan Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#16 CC#17 CC#18 CC#19 CC#48 CC#49 CC#50 CC#51 C5 C#5

51 [Volume]

Name Master Volume FX1 Volume FX2 Volume FX3 Volume FX4 Volume FX5 Volume FX6 Volume FX7 Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#80 CC#81 CC#82 CC#83 CC#87 CC#88 CC#89 CC#90 C5 C#5

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



 

Note Note

G Ch:01G Ch:01G

D2 D#2

Free Free

Select “Open...” from the “File” menu and open the song file “DP_M50”.

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Press the “OPTIONS” button and open the Preference dialog. Set the MIDI controllers as below.
A: CC#0, B: CC#1, C: CC#2, D: CC#3, E: CC#4, F: CC#5, G: CC#6, H: CC#7

G Ch:01G Ch:01G

D2 D#2

Note Note

Press the “OPTIONS” button to open the “Settings” dialog. Confirm that “USE STD. CC#7 / CC#10 VOL-
UME & PAN” is active. In case it is not active, click it.G Ch:01G Ch:01G

E4 F4

Note Note

On the “MASTER” page, locate the “CONTROLLER DEFINE” parameters then press the “LOAD” button 
for “CONTROLLER ASSIGN” to load the setup file “KORG M50.f7c”.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT
52

MOTU

MachFive

Name Filter Cutoff Filter Resonance Drive Transpose Fine Tune LFO 1 Rate LFO 2 Rate Part Pan Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#75 CC#76 CC#77 CC#96 CC#97 CC#10 C2 C#2

53

Digital Performer

[Pan]

Name Track 1 Pan Track 2 Pan Track 3 Pan Track 4 Pan Track 5 Pan Track 6 Pan Track 7 Pan Track 8 Pan Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 Off Off

54 [Level]

Name Track 1 Level Track 2 Level Track 3 Level Track 4 Level Track 5 Level Track 6 Level Track 7 Level Track 8 Level Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off

55

Native Instruments

B4

[A]

Name
PERCUSSION VOL-
UME

PERCUSSION DECAY VIBRATO MIX VIBRATO DEPTH TUBE AMP DRIVE TUBE AMP BODY TREBLE ROTOR TONE BASS ROTOR TONE Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#70 CC#71 CC#73 CC#74 CC#76 CC#78 CC#80 CC#90 C4 D4

56 [B]

Name UPPER MANUAL 16'
UPPER MANUAL 5 1/
3'

UPPER MANUAL 8' UPPER MANUAL 4'
UPPER MANUAL 2 2/
3'

UPPER MANUAL 2'
UPPER MANUAL 1 2/
3'

UPPER MANUAL 1' Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#12 CC#13 CC#14 CC#15 CC#16 CC#17 CC#18 CC#20 C4 D4

57

B4 Organ II

[A]

Name
PERCUSSION VOL-
UME

PERCUSSION DECAY VIBRATO MIX VIBRATO DEPTH Rotator Slow/Fast Rotaor Run Reverb DRIVE Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#70 CC#71 CC#73 CC#74 CC#1 CC#2 C#84 CC#76 C4 D4

58 [B]

Name Upper Drawbar 16' Upper Drawbar 5 1/3' Upper Drawbar 8' Upper Drawbar 4' Upper Drawbar 2 2/3' Upper Drawbar 2' Upper Drawbar 1 1/3' Upper Drawbar 1' Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#12 CC#13 CC#14 CC#15 CC#16 CC#17 CC#19 CC#20 C4 D4

59 Battery

Name Controller A Controller B Controller C Controller D Controller E Controller F Controller G Controller H Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#0 CC#1 CC#2 CC#3 CC#4 CC#5 CC#6 CC#7 C2 C#2

60 Elektrik Piano

Name
Sound Control Knob 
1

Sound Control Knob 
2

Sound Control Knob 
3

Sound Control Knob 
4

Pan Volume Free Free Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#20 CC#21 CC#22 CC#23 CC#10 CC#7 off off C4 D4

61

FM7

[A]

Name
Easy Edit Timbre 
Brightness

Easy Edit Timbre Har-
monic

Easy Edit Timbre 
Detune

Easy Edit Timbre Env 
Amount

Easy Edit Timbre 
Envelope Attack

Easy Edit Timbre 
Envelope Decay

Easy Edit Timbre 
Enve-lope Sustain

Easy Edit Timbre 
Enve-lope Release

Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#102 CC#103 CC#104 CC#105 CC#106 CC#107 CC#108 CC#109 C4 D4

62 [B]

Name Filter Cutoff Filter 1 Resonance
Filter Envelope 
Amount

Filter 1 Mode
Easy Edit Volume 
Envelope Attack

Easy Edit Volume 
Envelope Decay

Easy Edit Volume 
Enve- lope Sustain

Easy Edit Volume 
Enve-lope Release

Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#111 CC#112 CC#113 CC#110 CC#114 CC#115 CC#116 CC#117 C4 D4

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



 

Note Note

On the “MASTER” page, locate the “MIDI Controller Assignment” parameters then press the “LOAD” 
button for “CONTROLLER ASSIGN” to load the setup file “KORG MIDI Assignment.f8c”.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note 1: Copy the setting file “KORG MIDI Setup.mca” into the following folder. Windows: “mca” folder in 
the folder where the Massive is installed. 
(e.g. C:/Program Files/Native Instruments/Massive/mca)
Mac: /Library/Application Support/Native Instruments/Massive/mca

2: Select “Preference...” in “Massive” menu to open “Massive Options”. Double-Click “KORG MIDI 
Setup” in the “Midi Setups” of “Midi” page to turn it “on”.

G Ch:01G Ch:01G

E4 F4

Note Note

Click the “NI” logo. Select “Load Controllermap” in the displayed menu and load “DefaultMap.txt” 
from the “Presets”-“Controller maps” folder inside the folder where PRO-53 is installed.G Ch:01G Ch:01G

E4 F4

Free Free

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

D2 D#2

Note Note

G Ch:01G Ch:01G

D2 D#2

Note Note

G Ch:01G Ch:01G

D2 D#2

Note Note

G Ch:01G Ch:01G

E4 F4

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting
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Native Instruments

FM8

[A]

Name Timbre Harmonic Timbre Detune Timbre Brightness Timbre Env Amount Timbre Env Attack Timbre Env Decay Timbre Env Sustain Master Volume Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#83 CC#20 CC#74 CC#79 CC#85 CC#86 CC#87 CC#7 C4 D4

64 [B]

Name LFO Rate LFO Vibrato LFO Timbre LFO Tremolo Volume Env Attack Volume Env Decay Volume Env Sustain Volume Env Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#90 CC#103 CC#104 CC#105 CC#73 CC#75 CC#70 CC#72 C4 D4

65 Massive

Name Filter 1 Cutoff Filter 1 Resonance Filter 2 Cutoff Filter 2 Resonance Env 4 Attack Time Env 4 Decay Time Env 4 Decay Level Env 4 Release Time Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#30 CC#68 CC#73 CC#75 CC#70 CC#72 C4 D4

66 PRO-53

Name
Oscillator A Pulse 
Width

Oscillator B Pulse 
Width

Filter Cutoff Filter Resonance Amplifier Attack Amplifier Decay Amplifier Sustain Amplifier Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#43 CC#55 CC#70 CC#71 CC#80 CC#81 CC#82 CC#83 C4 D4

67

Propellerhead

Reason Mixer

[Pan]

Name Channel 1 Pan Channel 2 Pan Channel 3 Pan Channel 4 Pan Channel 5 Pan Channel 6 Pan Channel 7 Pan Channel 8 Pan Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#23 CC#24 CC#25 CC#26 CC#27 CC#28 CC#29 CC#30 Off Off

68 [Volume]

Name Channel 1 Level Channel 2 Level Channel 3 Level Channel 4 Level Channel 5 Level Channel 6 Level Channel 7 Level Channel 8 Level Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 CC#9 CC#10 CC#12 CC#13 CC#14 CC#15 CC#16 Off Off

69 Dr.Rex

Name Filter Freq Filter Res Filter Mode Filter Env Amount Amp Env Attack Amp Env Decay Amp Env Sustain Amp Env Release Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#76 CC#18 CC#73 CC#9 CC#12 CC#72 C4 D4

70 Malstrom

Name OSC A motion OSC A shift Filter A res Filter A Freq OSC B motion OSC B shift Filter B res Filter B Freq Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#92 CC#86 CC#78 CC#79 CC#43 CC#44 CC#71 CC#74 C4 D4

71 NN 19

Name Filter Freq Filter Res Filter Mode Filter Env Attack Filter Env Decay Filter Env Amount mp Env Attack Amp Env Decay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#76 CC#14 CC#15 CC#18 CC#73 CC#9 C4 D4

72 NN-XT

Name Filter Freq Filter Res Amp Env Attack Amp Env Decay Amp Env Release Mod Env Decay Master Volume Free Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#73 CC#9 CC#72 CC#15 CC#7 off C4 D4

73

ReDrum

[Pan]

Name Drum 1 Pan Drum 2 Pan Drum 3 Pan Drum 4 Pan Drum 5 Pan Drum 6 Pan Drum 7 Pan Drum 8 Pan Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#19 CC#20 CC#21 CC#22 CC#23 CC#24 CC#25 CC#26 C2 C#2

74 [Level]

Name Drum 1 Level Drum 2 Level Drum 3 Level Drum 4 Level Drum 5 Level Drum 6 Level Drum 7 Level Drum 8 Level Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 CC#9 CC#10 CC#12 CC#13 CC#14 CC#15 CC#16 C2 C#2

75 [Pitch]

Name Drum 1 Pitch Drum 2 Pitch Drum 3 Pitch Drum 4 Pitch Drum 5 Pitch Drum 6 Pitch Drum 7 Pitch Drum 8 Pitch Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#51 CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 C2 C#2

76 Subtractor

Name OSC 1 Phase OSC 2 Phase FM MIX Filter 1 Freq Filter 1 Resonace Filter 2 Freq Filter 2 Resonace Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#93 CC#106 CC#108 CC#107 CC#74 CC#71 CC#79 CC#78 C4 D4

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



 

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

Load the “StylusRMX_KORG.mlt_rmx” as the MIDI Learn set file.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Free Free

First, you need to install the KORG USB/MIDI driver.
1: Select “Device Setup...” from the “Devices” menu and open the “Device setup” dialog. Select 

“Generic Remote” from the “Devices” list in the left column. Select “keyboard” for the “MIDI input” 
and press the “Import” button. Load “Cubase_KORG.xmll”. (If you do not find “Generic Remote” in 
the left column, please add it using the “Add/Remove” function.)

2: Press the “Apply” button.

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT
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Spectrasonics

Atmosphere

Name Layer A Pan Layer A Level Layer B Pan Layer B Level Cutoff Resonance Master Filter Master Resonance Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#83 CC#81 CC#84 CC#82 CC#77 CC#78 CC#74 CC#71 C4 D4

78

Stylus RMX

[A]

Name FILTER LFOS RATE FILTER LFOS DEPTH FILTER LFOS WAVE CHAOS DOWN/UP CHAOS RANGE POWER FILTER MODE POWER FILTER DRIVE POWER FILTER GAIN Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#16 CC#17 CC#18 CC#19 CC#48 CC#49 CC#50 CC#51 C4 D4

79 [B]

Name CHAOS PATERN CHAOS REPEAT CHAOS REVERSE SAMPLE START CHAOS PITCH
POWER FILTER CUT-
OFF

POWER FILTER RESO
POWER FILTER 
WIDTH

Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#80 CC#81 CC#82 CC#83 CC#87 CC#88 CC#89 CC#90 C4 D4

80 Trilogy

Name Layer A Pan Layer A Level Layer B Pan Layer B Level Cutoff Resonance Master Filter Master Resonance Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#83 CC#81 CC#84 CC#82 CC#77 CC#78 CC#74 CC#71 C4 D4

81

Steinberg

Cubase

[Audio Pan]

Name Audio Pan1 Audio Pan2 Audio Pan3 Audio Pan4 Audio Pan5 Audio Pan6 Audio Pan7 Audio Pan8 Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 Off Off

82 [Audio Level]

Name Audio Level 1 Audio Level 2 Audio Level 3 Audio Level 4 Audio Level 5 Audio Level 6 Audio Level 7 Audio Level 8 Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off

83 [MIDI Pan]

Name MIDI Pan1 MIDI Pan2 MIDI Pan3 MIDI Pan4 MIDI Pan5 MIDI Pan6 MIDI Pan7 MIDI Pan8 Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#41 CC#41 CC#41 CC#41 CC#41 CC#41 CC#41 CC#41 Off Off

84 [MIDI Level]

Name MIDI Level 1 MIDI Level 2 MIDI Level 3 MIDI Level 4 MIDI Level 5 MIDI Level 6 MIDI Level 7 MIDI Level 8 Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#35 CC#35 CC#35 CC#35 CC#35 CC#35 CC#35 CC#35 Off Off

85 A1

Name Oscillator 1 FM Filter Cutoff Filter Resonance Filter Drive Fitler Env Attack Filter Env Decay Amp Env Attack Amp Env Decay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#74 CC#71 CC#29 CC#37 CC#38 CC#24 CC#25 C4 D4

86 Monologue

Name OSC1 DEPTH OSC2 PWM OSC2 DEPTH FX OVER DRIVE FX DEPTH FX MIX DELAY FBK DELAY MIX Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#103 CC#19 CC#105 CC#70 CC#15 CC#93 CC#12 CC#91 C4 D4

87 Tonic

Name ENV MOD ATTACK ENV MOD RELEASE RES CUTOFF DRIVE LFO MOD DEPTH LFO MOD RATE LFO MOD STEPS Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#73 CC#72 CC#71 CC#74 CC#70 CC#77 CC#76 CC#82 C4 D4

88 Embracer

Name OSC1 WAVE OSC1 TONE OSC1 WIDTH OSC2 WAVE OSC1 TONE OSC1 COARSE OSC1 WIDTH MASTER RELEASE Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#9 CC#74 CC#16 CC#14 CC#76 CC#83 CC#18 CC#72 C4 D4

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



 

Free Free

In the host application, change the MIDI output channel for the MIDI track you want to use “Groove 
Agent” on to “ANY” or other multi-channel outputs.

G Ch:01G Ch:01G

Off Off

Free Free

 Enable “RECEIVE MIDI CONTROLLER” in “KEY/CONTROL OPTION” of the “OPTIONS” page.G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Free Free

G Ch:01G Ch:01G

Off Off

Note Note

 In the host application, change the MIDI output channel for the MIDI track on which “Attack” is used 
for each of the sounds that you want to remote-control such as kick, snare, drum, etc.

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

 Drum Open HH Closed HH

G Ch:01G Ch:01G

F#4 C4

 Drum Open HH Closed HH

G Ch:01G Ch:01G

A#2 F#2

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

Note Note

G Ch:01G Ch:01G

E4 F4

 

Switches

 

1:  These operations will overwrite the previous MIDI Control settings. If necessary, back up the previ-
ous controlMidi file.

2:  When the MIDI channel settings of the host application and the plug-in software are the same, proper 
control may not be available. Please change the MIDI channel setting on either the host application or 
the plug-in software. Please refer to the application’s manual for the correct setting

 

2 3 4 HINT
89

Steinberg

Groove Agent

Name Kik Volume Snare Volume Tom Volume Hi-Hat Volume Ride Volume Crash Volume Perc 1 Volume Perc 2 Volume Free Free

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#73 CC#73 CC#73 CC#73 CC#73 CC#73 CC#73 CC#73 Off Off

90 HALion

Name DCF CUTOFF DCF RESONANCE DCF VELOCITY DCF ENV. AMOUNT DCF Envelope1 A DCF Envelope1 D DCA ENV. AMOUNT VOLUME Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#15 CC#80 CC#83 CC#89 CC#70 CC#7 Off Off

91 Hypersonic

Name GM Edit: cutoff GM Edit: resonance GM Edit: filt env att
GM Edit: filt env 
dec+rel

GM Edit: amp env att GM Edit: amp env dec GM Edit: amp env rel Volume Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#74 CC#71 CC#77 CC#78 CC#73 CC#75 CC#72 CC#7 Off Off

92 Virtual Guitarist

Name Shuffle Dynamics Timing Decay Stereo Width Presence Low Cut Mic Position Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#76 CC#79 CC#78 CC#75 CC#74 CC#81 CC#80 CC#82 Off Off

93

Waldorf

Attack

Name Osc 1 Pitch Osc 1 Level Osc 2 Pitch Osc 2 Level Osc 1 P Env Osc 2 P Env Cutoff Resonance Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#13 CC#28 CC#22 CC#30 CC#14 CC#23 CC#37 CC#38 C4 D4

94 PPG Wave 2.V

Name BASIS VCF-CUTOFF VCF-EMPHASIS ENV1>VCF WAVES-OSC WAVES-SUB ENV1>WAVES VOLUME Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#8 CC#74 CC#71 CC#28 CC#26 CC#27 CC#30 CC#7 C4 D4

95

ToonTrack

dfh

Name Free Free Free Free Free Free Free Free Bass Drum Snare

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note Off Off Off Off Off Off Off Off C2 G#1

96 EZ Drummer

Name Free Free Free Free Free Free Free Free Bass Drum Snare

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note Off Off Off Off Off Off Off Off B1 E2

97

UltimateSoundBank

PLUGSOUND PRO

[Pan]

Name Timbre 1 Pan Timbre 2 Pan Timbre 3 Pan Timbre 4 Pan Timbre 5 Pan Timbre 6 Pan Timbre 7 Pan Timbre 8 Pan Note Note

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 C4 D4

98 [Volume]

Name Timbre 1 Volume Timbre 2 Volume Timbre 3 Volume Timbre 4 Volume Timbre 5 Volume Timbre 6 Volume Timbre 7 Volume Timbre 8 Volume Note Note

Ch Ch:01G Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01G Ch:01

CC#/Note CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 C4 D4

99 Charlie

Name Filter Cutoff Filter Resonance Master filter cutoff
Master filter reso-
nance

Layer one level Layer two level Amp Envelope Attack Amp Envelope Decay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#78 CC#74 CC#71 CC#81 CC#82 CC#73 CC#75 C4 D4

100 Ultra Focus

Name Filter Cutoff Filter Resonance
Master filter cut fre-
quency

Master filter reso-
nance

Layer A Level Layer B Leve Amp Envelope Attack Amp Envelope Decay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#78 CC#74 CC#71 CC#81 CC#82 CC#73 CC#75 C4 D4

101 X-treme FX

Name Filter Cutoff Filter Resonance
Master filter cut fre-
quency

Master filter reso-
nance

Layer A Level Layer B Leve Amp Envelope Attack Amp Envelope Decay Note Note

Ch Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01G Ch:01

CC#/Note CC#77 CC#78 CC#74 CC#71 CC#81 CC#82 CC#73 CC#75 C4 D4

Knobs

Manufacturers Product Name Scene 
Variation 1 2 3 4 5 6 7 8 1



  
Manufacturer Name
• KORG These product names are the trademark or a registered trademarks of KORG Inc.
• Ableton This product name is a trademark or a registered trademark of Ableton AG.
• Applied Acoustics Systems These product names are the trademark or a registered trademarks of Applied Acoustics Systems DVM Inc.
• Arturia These product names are the trademark or a registered trademarks of Arturia SA.
• Apple This product name is a trademark or a registered trademark of Apple Inc.
• Fxpansion This product name is a trademark or a registered trademark of FXpansion Audio UK Ltd.
• GMEDIA These product names are the trademark or a registered trademarks of GMEDIA Music.
• Image-Line Software This product name is a trademark or a registered trademark of Image-Line Software.
• MOTU These product names are the trademark or a registered trademarks of Mark of the Unicorn, Inc.
• Native Instruments These product names are the trademark or a registered trademarks of Native Instruments Software Synthesis GmbH.
• Propellerhead These product names are the trademark or a registered trademarks of Propellerhead Software AB.
• Spectrasonics These product names are the trademark or a registered trademarks of Spectrasonics.
• Steinberg These product names are the trademark or a registered trademarks of Steinberg Media Technologies GmbH
• Waldorf and the Waldorf Logo are registered trademarks of Waldorf Music GmbH Germany.
• ToonTrack These product names are the trademark or a registered trademarks of Toontrack Music.
• UltimateSoundBank These product names are the trademark or a registered trademarks of Univers Sons, SA.
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